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What is Linux, why is it free?

Linux is a free open source computer operating system first created by Linus Torvalds in 1991. It is
licensed under the General Public License (GPL). This license allows Linux to be modified, copied
or redistributed by anyone in a completely “free” way. Thousands of volunteer developers around the
world work on Linux improvements and contribute new applications.
GPL software is known as “open-source” this means the source code is publicly available to share
with others. In contrast, proprietary software such as Microsoft Windows is “closed-source”, the
code is not readily available and it is illegal to copy and share the software.
Software  useful  for  families,  students  and  concession  holders  has  been  included  on  the
Computerbank computer. Enjoy!
Using free Linux software enables Computerbank to keep the costs of our computers low.
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Setting Up Your Computerbank Computer
It's easy to panic when you arrive home with your new computer, many people feel like this. Follow these
simple steps to set up your computer and you will be computing in no time. Check the index on the 
previous page to find the answer any other question you may have.

Desktop Computer
1. Plug the mouse into a USB socket at the back of the computer
2. Plug the keyboard into a USB socket at the back of the computer

The USB sockets at the front of your computer are convenient to plug in
USB devices.

3. Connect your monitor (screen) to your computer. 
You will have either a DVI monitor connection or a VGA Monitor Connection. (see below)

         OR 

4. Plug in the power cord for the screen
5. Plug in the power cord for the computer
6. Switch on the monitor then the computer.

Laptop Computer
Plug in the AC power cord to the power pack and the DC power cord to the laptop.
Switch on the computer. 
Starting the computer.
A login screen will appear in about a minute.
Enter the password and the operating system will load.
If you want to change the system so that a password is not needed to log in, see Appendix 3 - change 
automatic login Page 18.
Turning off the computer.
To turn off your computer, click on the Menu button located at the bottom left of the screen, 
then Click the switch  then “Shutdown” and your computer will turn off.

If you just switch the power off, you may lose data and/or the computer may not boot.
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Using your computer
Applications on the computer are organised into 
categories. Hover the mouse over the category to 
display the programs in it. Hover the mouse over the
program name and its name and description will be 
shown at the bottom right of the menu. Start a 
program by clicking on its name.
The panel at the left of the menu gives quick access
to some applications. Hover the mouse over the 
icon and its name and description will be shown at 
the bottom right of the menu.
Places is the access point for the file manager.
Click on the menu, move the mouse over Places, 
then move the mouse to the folder you want and 
Click.

The search bar at the top of the menu can be used 
to search for an application by name.

The icons in the panel at the left of the menu have the following meanings:
Firefox web browser

Software Manager

System Settings

File Manager

Lock Screen

Logout

Shutdown the computer

NOTE: The picture of the menu above has a different background to that on the computer. The dark 
icons show better when printed on a light background, but the contrast on the screen is better with a 
dark background.
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Managing Your Content
Linux system folders have slightly
different names compared to
Windows and Mac. For example in
Windows word processor files would
be in “My Documents”. In Linux word
processor files would be in
“Documents”.
In the screenshot, the person logged
in is called user. (user is the login
name we gave you).  On the right side
of the screen are the folders in user’s
home directory.

To see the files: Double click on a
folder to view contents. 

Organising your files
The files on the computer are very
similar to a filing cabinet. Over time,
you will gather many files in your
folders. To help with the management
of these files, folders can be created inside the Home folder to store related items together.  The 
screenshot above shows the standard set of folders in a user’s home folder.

Creating a new folder
Open the folder where you want to create the new folder.  Right click your mouse in a blank area of the 
file manager screen. Select Create New Folder OR in the top menu of the file manager click File  > 
Create New Folder. Change the name to what you want.
Copying and Moving files and folders
Manage files by dragging and dropping or using cut and paste. NOTE: dragging a file or folder from one 
place in your home folder to another place in the home folder will move it.
The Edit menu can be used for moving and copying: Cut and Paste for move or Copy and Paste to copy.

Another method is to right click on the file or folder and choose Cut or Copy, then change to the 
destination folder, right click on a blank area of the window (make sure that no file or folder is selected) 
and choose Paste. You can also right click on a folder and “Paste Into Folder”.

Backing up your data
It's crucial you keep copies of your important content. In any computer a hardware or software 
failure may occur. Making a copy of your information saves angst and anger. Backup your work by 
copying important files to an external drive or DVD disc. Keep this data separate from your computer.

Comparison:  Linux and Microsoft Windows File Storage
Location on Microsoft Windows Location on Linux

My Documents ~/Documents
My Pictures ~/Pictures

CD or DVD ‡ /media/cdrom0

USB storage ‡ /media/user/“name of device”

‘~’ means “/home/user”. user is the login ID of the person logged in. 

‘‡’ drive letter e.g. D:\ CDs and DVDs usually start at D:, USB storage can be any drive letter to Z
Removable devices such as DVDs and USB storage devices appear in the left hand panel of the file 
manager with an “Eject” icon .

NOTE: Actual location and even the name may be different on different versions of Windows."
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Internet Connections
Cable, ADSL or NBN connection
These systems will have a modem or router with an ethernet connector (picture at
right). Connect your ethernet cable from the modem or router to the computer.
(Ethernet cables that come with modems are usually yellow. Other ethernet cables are
usually blue). The network manager icon will animate for a time. A message about
being connected to a wired network will be displayed. Your computer should now be
connected to the Internet. 
If this is not successful, try clicking the network manager icon and disconnect, then connect again. If this
is not successful, you may need to configure the modem. 
These modems are usually configured using a web browser. Follow the instructions provided with your 
modem. You will need the username and password the ISP gave you (not the username and password 
for your computer).
USB Modems – Broadband (ADSL or Cable – not mobile broadband) 
Broadband modems with USB connections generally do not work with Linux. You need to use a 
broadband modem with an Ethernet connection. 

WiFi connection
If your computer is capable of WiFi (laptops are, but few
desktops) click on the Network Manager icon to show the list of
available WiFi networks.
If you do not see a list of WiFi networks, make sure that there
is a tick in the “Wireless” entry in the list and that WiFi is on.
Some laptops have a switch to turn WiFi on, others use a key
combination.
Find your WiFi network in the list. (If it is not displayed, move
the mouse over “More”. You may need to scroll the list.)
Click on the network name. You will be asked to enter the
access password – you only need to do this the first time.
After a short wait, you should see a “Connected” message.
NOTE: If you click on ‘Cancel’, a connection will be created
without a password. Appendix 2 (Page 18) details the method
of fixing this.
If you don't have a wireless adaptor, call Computerbank to ask
what brand to get. Computerbank usually has wireless cards and USB WiFi adapters available at low 
cost. 

Mobile broadband modems
There are a number of different types of Mobile Broadband modems. The easiest to use are those that 
connect with WiFi. It is only necessary to power the modem and use Network Manager to select the 
correct WiFi name, then enter the password.
Other Mobile Broadband Modems connect in one of two ways. Most require the use of Network 
Manager to configure the connection. This only needs to be done the first time the modem is plugged in.
The details are in Appendix 1 part A (Page 16). This appendix also details how to use the modem to 
send and receive SMS messages.

Some modems will connect automatically as though they are a wired connection. These will give a 
message like ‘You are now connected to wired connection 2’. These do not require configuration. 
Appendix 1 part B (page 17) gives details on sending and receiving SMS messages and how to 
reconfigure the modem if it loses its settings.

Checking mobile broadband usage
All mobile broadband service providers have an online facility to check account usage. Check with your 
provider. Note: the data may be up to 48 hours behind your usage.

You can also check the amount of data you are sending and receiving with “Modem-Manager-GUI” (see 
Appendix 1, Part A: page 16) or the Modem’s web interface (Appendix 1, Part B: page 17)

Using your Smart Phone's Data for your computer's Internet Connection
If you have an appropriate smart phone with a good amount (at least 1GB) of data allowance, you can 
connect your phone to your computer using a USB cable. On the phone, go to Settings and turn on your
USB Tethering. The phone should connect as a Wired Connection. 

You may also be able to use your phone as a WiFi hotspot. This will need to be configured. 
WiFi security should be set to WPA2 PSK.
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Accessing Email
Computerbank recommends using free webmail services such as Gmail (mail.google.com) or Yahoo 
(au.mail.yahoo.com). The advantage of webmail is you can log in on any computer with internet access.

Adding a Printer
Not all printers work under Linux. The most compatible are HP and Epson Other brands are providing 
better support than they did previously. Please call us before you buy a printer to make sure that it is 
compatible with Linux. Many printers will install automatically but you should call Computerbank to see if 
you will need to bring the computer and the printer to Computerbank for driver installation. Do not use 
the disc that is supplied with the printer. This is for Windows and will not work with Linux. 
Computerbank cannot provide support for all printers, they all work differently. 

Setting up a Printer
Connect the printer to a USB connector at the back of your computer, put paper in, then turn the printer 
on. Wait a while as some printers will automatically set up. If successful, a box will appear confirming the
printer details.  A test page can also be printed.  
Manual set up can be attempted if automatic set up does not occur.
Manual Printer Setup

To set up your printer click on Menu: Administration > Printers 
In the Printers Utility (at left)
1. Click on Add
2. The utility will search for any connected printers.
3. Select your printer from the choices and click the forward button.
4. Describe your printer and click Apply. Accepting the suggestions 
is OK.

5. Finally, when prompted, print a test page to see if the setup 
worked. If not correct, call Compuerbank.

Using CDs, DVDs and USB devices
Place removable media gently into your computer's drive or USB slot.  An icon will
appear on the desktop and in the file manager. Places will have an extra item and
the file manager will have a new Devices section with the device name added. 
Storage media can be safely removed in a number of ways. Close applications and
any documents using removable media before unmounting or ejecting. Failing to do
this may result in an error about a “busy” device

In the file manager, in the Devices section, click the Eject icon beside the device you want to 
remove. A CD/DVD may not eject if busy. 
You can right click the appropriate icon on the desktop or from within the file manager. Select Eject or 
Safely Remove Drive. For CD and DVD media, pressing the eject button on the device can also work. 
Wait a few moments before removing USB media (If there is an activity indicator, wait for it to stop 
flashing.)
A “Safe to remove” message will appear when writing to the USB is complete.
Warning: removing a USB while it is still being used can cause loss of data.

Copying a File or Folder to a USB Memory Stick
The Edit menu can also be used to copy a folder: 
1. Insert the memory stick into a USB port
2. When the file manager opens, change to the folder that contains the files/folders you want to copy
3. Select the files/folders to copy
4. Click the Edit menu
5. Select Copy
6. From the left pane select the appropriate location and move to the destination folder
7. Go to the Edit menu again
8. Select Paste to place the file on the removable media. 
9. Before removing the memory stick, Eject or Safely Remove it.

Keyboard shortcuts like Ctrl+C (copy) and Ctrl+V (paste) can also be used. Files can be accessed by 
double clicking them to open. 
Note: Multiple selections can be made by clicking on one file/folder to select it, then holding the Ctrl key 
and clicking the other files/folders you want.
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Listening to an Audio CD
Listen to a CD with Rhythmbox Music Player. It is found in Menu: Sound & Video > Rhythmbox. It will 
start automatically when an audio CD is inserted but music playing does not start automatically. Click the
play button. 
MP3, wav, ram, or ogg recordings are played using Rhythmbox Music Player or VLC Media Player 
located in Sound & Video in the Menu. 

Note: You need speakers or headphones to hear to audio recordings or DVD movies. Laptops have 
built-in speakers, but they do not produce good sound. Some desktops have built-in speakers but they 
are not usually stereo and usually poor sound quality.

To close Rhythmbox, you should use Alt+F4. Clicking the X closes the window with Rhythmbox still 
playing. 

Another method is to click the Music icon (♫) in the panel and click the x beside Rhythmbox.

Watching a DVD Movie
Put a DVD movie disc gently into the drive.  The DVD will start playing automatically.
To watch full screen, press F on the keyboard, double click the movie or click on the Video menu item 
and then select Full Screen. To get back to the regular view, press F, ESC or right click and select 'Full 
Screen' again. 
Explore the other menus to find out what else VLC can do. 

Safely Closing Down and Ejecting a Disk
Close down VLC by selecting File > Exit or click the x in the window title bar. The disk can be safely 
ejected by pressing the button on the DVD player.  You can also right click the DVD icon on the desktop 
and select “Eject”. 

Burning CDs or DVDs
Burn CD's and DVD's with Brasero - Menu: Sound & Video

Will my Scanner or Camera work with Linux?
Cameras – Most digital cameras are supported under Linux. They usually look like USB storage 
devices. If not, the storage card can be removed and used in a card reader to access the pictures.

Scanners – Many stand-alone scanners are not supported under Linux. Scanners that are part of 
supported printers usually are supported. The Document Scanner application (Graphics menu) will work 
with most supported scanners.  For compatible scanners see: http://www.sane-project.org/sane-
supported-devices.html

Keyboard shortcuts for Linux Mint
Keyboard shortcuts are a quick way to use your computer. Many Linux shortcuts are similar to shortcuts in other 
software. Keyboard shortcuts are listed next to menu items in some applications.
Some keyboard shortcuts:
[Ctrl]+[C] Copy
[Ctrl]+[X] Cut
[Ctrl]+[V] Paste
[Alt] + [Tab] Cycles through open applications
[Windows Key] Brings up the main menu
[Alt] + [F2] Brings up the run dialog box
[Alt] + [F4] Closes a window
[Ctrl] + [Alt] + [Del] Brings up the logout dialog box
[Ctrl] + [Alt] + [End] Brings up the shutdown dialog box

9

http://www.sane-project.org/sane-supported-devices.html
http://www.sane-project.org/sane-supported-devices.html


Word Processing with LibreOffice
LibreOffice is similar to Microsoft Office. Importantly it can read and save in the Microsoft file formats. 
This means files you create with LibreOffice can be used on Windows or Apple computers that have 
Microsoft Office. LibreOffice has its own file format and you can also save your documents as PDFs if 
you wish. The Computerbank system saves in Microsoft formats for compatibility with other systems.
LibreOffice is used by millions of people around the world for:

• word processing
• spreadsheets
• slide presentations
• drawing
• database

Open LibreOffice word processing by clicking on the page icon in the bottom panel on your desktop. 
That is the quickest way to open LibreOffice Writer. Alternatively go to Office in the Menu. 
Scroll down and click on LibreOffice Writer. 
Note:  LibreOffice  cannot  read  Microsoft  Access  databases,  unless  they  have  been  converted  to  a
supported format such as ODBC, MySQL, dBase, text (csv), and spreadsheets. 
More information at http://www.libreoffice.org
There is a very useful Help system for LibreOffice (see below)

Comparison of LibreOffice and Microsoft Office File Types
LibreOffice Microsoft Office Libre Office file type Microsoft file types

Write Word odt doc, docx
Calc Excel ods xls, xlsx

Impress Powerpoint odp ppt, pps, pptx, ppsx
Base Access odb Not file compatible
Draw No equivalent odg No equivalent
Math Equation odf Can’t save as file

LibreOffice can read, edit and save the Microsoft Office file types listed.
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Applications on your Computerbank Computer
Go to the Menu at the bottom left of your screen
The following list shows the software in the order you will find it in the menu.

Accessories
Archive Manager: Software to handle archives like zip, tar, bzip, rar and more
Calculator: A calculator
Character Map: View fonts on the computer.
Files: File Manager
Image Viewer: View digital images
Screenshot: Take a screenshot of the desktop or a window
Text Editor: Editor for plain text files

Games
AisleRiot Patience: Many patience card games

Graphics
Document Scanner: Used with scanners to scan images and documents
Drawing: Drawing program for digital artists
GIMP Image Editor: An advanced graphics program similar to Photoshop
Pix: Photo Manager and simple editor

Internet
Chrome Google Chrome web browser
Firefox Web Browser: Firefox web browser
Modem-Manager-GUI Adds SMS and monitoring capability to USB Broadband Modems

Office
Calendar: Digital Diary
Library Organise favourite and frequently used documents
LibreOffice Calc: Spreadsheet similar to Microsoft Excel
LibreOffice Draw: Drawing application
LibreOffice Impress: For presentations similar to Microsoft Powerpoint
LibreOffice Math: Program for formatting mathematical equations
LibreOffice Writer: Word processing similar to Microsoft Word

Sound & Video
Audacity: For editing and recording sound
Brasero: CD and DVD Burning
Cheese: Save photos and videos from a web camera
Rhythmbox: Play MP3s, CD's and other audio files. Internet radio
VLC Media Player: Multimedia player

Administration
Backup Tool: Data backup
Disk Usage Analyzer View disk space usage
Power Statistics Power information (and Laptop battery information)
Printers: Configure and manage printers
Software Manager: Install and remove software
Update Manager: Checks for system updates
Users and Groups: Add users, turn off automatic login

Preferences
Account details Change user details and password
Display: Configure your monitor(s)
File Management: Change settings related to file management
Keyboard: Set your keyboard preferences
Languages: Language and Locale settings
Mouse and Touchpad: Change properties for the mouse (and touchpad on laptop)
Power Management: Manage Computer and Display power
Screensaver: Manage screen lock settings
System Info: Show system information
System Settings: Control Centre
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Customising your Computer
Here are some of the options for your desktop:
● Change font sizes to make the desktop easier to read
● Change your desktop background, theme 
● Languages (needs appropriate languages installed)
● Change mouse properties - left/right handed mouse
● Change keyboard options

To customise:
1. Go to Menu: System Settings 
2. In Appearance there are four options. 

Backgrounds allows setting of a background picture or slideshow (in “Settings”), 
Font Selection allows changing system font and size, 
Themes allows changing the way windows are displayed (colours, icons, mouse pointers), 
Effects changes the way items appear and disappear.

To change your mouse from right handed to left handed operation: 
Click on the Menu: Preferences > Mouse and Touchpad 

Creating Shortcuts
You can create shortcut icons on your desktop or in the panel to link to programs used regularly. 
Right click the program name in the menu. A submenu will appear. Click on the appropriate option.
Warning: “Uninstall” will ask for a password, if given, the program will be deleted from the computer.

Inputting a Language other than English
Keyboard languages can be changed from Menu: Preferences > Languages.

Screensaver
There is no screensaver. The Mint developers regard screensavers as a security problem. 
The screensaver option is used to change the lock screen characteristics.
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Frequently Asked Questions and How To's
Does Linux get computer viruses?
Linux is not currently threatened by many viruses unlike the Microsoft system which is plagued by 
viruses.  Computerbank’s Mint operating system comes with a built-in firewall. Mint is based on Ubuntu 
which is one of the most secure operating systems around.

Changing the user password
Click on Menu: > Preferences > Account Details and click in the password field. Your current password 
will be required. You will be required to confirm your new password. Your new password will need to be 
eight characters or more.

Adding another user account
To add another user, follow these steps: 

1. Click on Menu: Administration > Users and Groups
2. Enter your password in the Password field.
3. Click on “Add”
4. Fill in the details requested by the form: Full Name and Username, click Add.
5. Click on the new user’s name
6. Click on “No password set”
7. Set the password for the user (8 or more characters): click “Change”.
8. You can add another user or close the window.

User names work better in lowercase. 

Checking free space on the hard drive
In the file manager window, the free space is shown in the status bar.
Space used in a folder can be obtained by right click on the folder and choosing Properties.
More detail about usage is available from the Disk Usage Analyser in the Administration menu.

“Can I install ‘program name’?”
If you want to use an application that is not included on Computerbank’s system, you can search the 
Software Manager (in the Administration section of the Menu) to see if it or something similar is 
available.

The Software Manager usually will give a description of the selected application and an indication of the 
space it will take on your hard drive. There is a provision for user reviews but these seem to be few and 
far between.
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Updating, Installing and Deleting software
An internet connection is required to update or install software.

Updating
You must have internet access to update software.
When updates are available, an orange dot icon will show in the update icon in the panel: 

It may need a large download. The download size is shown at bottom left in the window.
Click on the icon to start the Update Manager.

If you see a message that the Update Manager needs to be updated – click ‘Install Updates’, you will be 
asked to enter your password.
The ‘Update Manager’ will start and display a list of updates. Click ‘Install Updates’, you will be asked to 
enter your password.
If you see a message that Firefox or
Chrome is out-of-date, use the
Update Manager to update.
Go to Menu: Administration  >
Update Manager. 
There will usually be more items in
the list.
To just update Firefox and/or
Chrome, remove the ticks from the
headings, then tick the boxes
against Firefox and/or Chrome.
Click ‘Install Updates’. You will be
asked to enter your password.

Removing or adding software
Software can be added, updated or removed with the Software Manager 
The Software Manager is in Menu: Administration  > Software Manager.
You will be prompted to enter your password when you Install, Remove or Update software.
CAUTION: Do NOT remove software you are unsure about. Always check you are not removing other 
programs by updating. 
Further information can be found using the Help option and by doing a web search. Include the term 
‘Linux’ and/or ‘Ubuntu’ when looking for information.  
NOTE: Messages may be displayed while installing or updating software.
Information messages can usually be ignored: press ‘Q’ to close the message.
Messages that ask if you want to update to a new version of a file should be answered with ‘N’ (no).
If this is the default, you can just press ‘Enter’.
Example:
Configuration file 'filename' 
 ==> Modified (by you or by a script) since installation. 
 ==> Package distributor has shipped an updated version. 
   What would you like to do about it?  Your options are: 
    Y or I  : install the package maintainer's version 
    N or O  : keep your currently-installed version 
      D     : show the differences between the versions 
      Z     : start a shell to examine the situation 
 The default action is to keep your current version. 
*** filename (Y/I/N/O/D/Z) [default=N]? 
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Troubleshooting Common Problems
Frozen or misbehaving programs or an unresponsive computer
Occasionally programs will freeze or start to behave strangely. If this happens you can end the program. 
Click on Menu: Administration > System Monitor and click on Processes.  This will show a list of 
programs (processes) running on the system. Click on the program you wish to end.   

If nothing works, shutdown the computer by holding the power button for 10 seconds.

Dialog window takes over screen and can't be closed
If you can not access the minimise, maximise or close button in a program or a dialog window the 
keyboard and mouse can be used to move the window. While holding the ALT key with left click, use 
your mouse to drag the window into a better position. 
Or you can press the Alt F7 keys together: you can then move the window with the mouse or cursor 
keys.

Restore lost main menu
1. Right click an empty space on the panel and select “Applets”
2. Make sure that “Manage” is selected
3. Type “me” in the search box or scroll to “Menu” and left click
4. Click the ‘+’ sign at the bottom left of the window.
5. Close the ‘Applets’ window.

Tip: If the icon does not go where you want it, right click the panel and select 'Panel edit mode'.
Left click on the icon and drag to move it. Click 'Panel edit mode' to turn it off.

Can't Access the Desktop Menu Bar
If a program has taken over the whole screen and Esc won't return you to the desktop, Press the Alt F7 
keys together. You can then move the window with the mouse or cursor keys.
Pressing Alt F4 keys together should close the program but you may lose unsaved work.

Printer not working
Check that the printer is turned on, that it has paper, that its cables are plugged in fully, and check if it is 
out of ink. If the ink is out, buy a replacement cartridge or refill. 
If the printer has stopped it will have a cross over it and will need to be refreshed once the problem has 
been rectified. Click on Menu: Administration > Printers. In many cases the printer will resume printing by
itself.

Stopping the printer
Print jobs can be stopped by clicking on Menu: Administration > Printers then right click on the printer 
and click on View Print Queue.  Print jobs can be deleted by selecting them and using the appropriate 
option from the Toolbar or by right clicking over an entry.

Can't read/open USB memory sticks
 The device may be faulty, unformatted or have been removed without closing correctly.  If you do not 
need the data that was on the device, you can reformat it: call Computerbank for help with this task. 

I can't connect to broadband internet
There are many reasons why this could be the case. 

• Check that all the cables are plugged in and going to the right places.
• Check that there is power to the modem and it is switched on. A red light on the modem usually 

indicates a problem.
• Is another computer using the same connection? If you take the cable out of the first computer 

and put it into another computer, the modem (or router) may need to be turned off and on at the 
wall (power cycled) for it to work.

• Check the configuration for the modem or router. This is accessed using a web browser (Firefox) 
and an IP address (eg: 192.168.1.1 or 10.1.1.1). You may need the manual for the device. 

Boot stops at a text screen
There will be a message like “Give root password for maintenance (or type control-D to continue)”
Call Computerbank to book User Support. You will need to bring the computer to Computerbank for 
diagnosis and repair.
Kernel Panic message
These are rare. Kernel panic messages usually occur when starting or booting up your computer.  Call or
email Computerbank: you will probably need to bring the computer to Computerbank for repair.
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Appendix 1 – Mobile Broadband Internet
A. Using Network Manager to connect to the Internet.
Initial setup.
Connect the mobile broadband device to the computer and wait for approximately 30-40 seconds for the 
computer to recognise the device as a modem. You may see the message :

1. Click the Network Manager icon in the top right hand side of the top panel. If your device has 
been successfully detected an option to configure it will be available. 

2. Select New Mobile Broadband Connection and a wizard should appear. Select the correct 
information for your account. Some providers require a user name and password, while others do
not. 
When successful, a message similar to that below will appear.

3. If your connection does not work despite it being available call Computerbank for advice. It is 
probably a settings issue. 

On subsequent occasions, after the ‘registered’ message appears, click on the Network Manager icon 
and select the network [Provider] [Network name].
When you have finished using the internet, click on the Modem Manager icon and choose Disconnect 
before removing the modem.

Sending and receiving SMS messages
Phone companies send SMS messages when you reach 50%, 85% and 100% of your Data Allowance. 
“Modem Manager GUI” can be used to receive these messages and can also be used to send SMS 
messages.

“Modem Manager GUI” is started from the 
Internet menu. It should be started after the 
“You are now registered …” message has 
been displayed.
The Traffic tab will show the amount of data 
that has been sent and received during the 
current session. 
The “Statistics” can show data used each 
calendar month.
When you have finished using the Internet, 
click on the Modem Manager icon and select
“Disconnect” before removing the device.
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Mobile broadband network.
You are now registered on the home network.

Connection established
You are now connected to [Provider] [Network name].

Modem Manager GUI



B. Modem connects as wired connection.
Some Mobile Broadband Modems connect as a wired connection. These will display the message:

You will now be connected to the Internet.
These devices can be configured with a web browser. 
Sending and receiving SMS messages
Put 192.168.8.1 as the web address and the browser will connect to the modem’s web interface. Use 
the “SMS” tab to send and receive messages.
A window at the right side of the screen shows connection information including data used (“Total 
Volume”).
When you have finished using the Internet, you can just remove the device. You should see:

If you can’t connect to the internet, check the configuration: Settings tab, Connection item. The picture at
right shows the correct settings.

Sending and receiving SMS
messages
Put 192.168.8.1 as the web address and
the browser will connect to the modem’s
web interface. Use the “SMS” tab to send
and receive messages.

An area at the right side of the screen
shows connection information including
data used (“Total Volume”).
See picture below.
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Disconnected
Ethernet network.

Connection established
You are now connected to ‘wired 
connection 2’.



Appendix 2 – Network Manager
Editing Network Manager settings
Click on the Network Manager icon and choose Network Connections…

To delete an unwanted connection, click on it then click the minus sign.

To change a WiFi connection’s password, click on it then click the gear icon
Clicking on the “Wi-Fi Security” tab will allow you to change the password.

When finished, click “Save”.

Appendix 3 - change automatic login
Go to Menu: Preferences > System Settings -
Administration > Login Window
You will be asked to enter your password

Click on Users

Set automatic login
Add the username you want to login automatically
to the Username field in the Automatic Login
section.

Stop automatic login
Delete the name from the Username field in the 
Automatic Login section.
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